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Chief Architect X15 Migration Guide - What's New in Chief Architect X15

What’s New in Chief Architect X15

Welcome to Chief Architect X15. This topic has been written to help our upgrading customers make a smooth transition
from earlier versions of Chief Architect to Chief Architect X15.
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Getting Started Checklist

There are many new features in Chief Architect X15, and many existing features have changed. The following list suggests
steps you should take before migrating your files to Chief Architect X15. More information about each of these steps can be
found after the list.

[ 1. Review the List of New and Improved Features by Chapter

There are a number of important reasons why you should familiarize yourself with the new and improved features in
Chief Architect X15:

e New and improved features allow you to produce drawings more efficiently, so it is to your advantage to use
them.

¢ Some changes to existing functionality may affect your accustomed drawing style and thus your productivity
if you are not aware of them.

¢ New features may affect your choice of settings in your template files, as well as your preferred Preferences
settings.

See New and Improved Features by Chapter on page 13.

[ 2. Review Migrating Legacy Content
Legacy users of Chief Architect often have library catalogs and other custom content that they want to continue using.
See Migrating Legacy Content on page 4.

[ 3. Review Migrating Legacy Settings
Before migrating Preferences, Toolbars, or Hotkeys, bear in mind that legacy settings may not be best suited for using
the new program version. See Migrating Legacy Settings on page 4.

[] 4. Review Migrating Legacy Templates

Before migrating Templates, bear in mind that they may not be set up to take advantage of new tools in the new
program version. See Migrating Legacy Templates on page 5.

[ 5. Review the Considerations for Legacy Files
Before opening a plan or layout file created in a previous version of Chief Architect, be aware of potential changes to

the file that could occur in the new program version. See Considerations for Legacy Files on page 5.

[1 6. Launch Chief Architect X15

Once you have learned about the new features in Version X15 and decided whether to migrate any custom settings from a
legacy program version, launch Chief Architect X15. The first time you launch, the Migrate Settings dialog will give you
the opportunity to bring legacy settings and content forward into Version X15.
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Migrating Legacy Content

Legacy users of Chief Architect Premier often have a wealth of library catalogs and other custom content that they have
built over time and want to continue using.

LEGACY LIBRARY CONTENT
There are several ways that legacy library catalogs can be brought into Chief Architect X15.

If you have Chief Architect version X5 through X14 installed on your computer, the Migrate Settings dialog will display
after you activate the license, allowing you to migrate library content as well as a selection of other settings for use in Chief
Architect X15. If multiple legacy versions are present on the system, only the data associated with the most recent will be
migrated.

You can import library files from Versions X1 through X5 at any time by selecting Library> Import Library (.calib,
.calibz) from the program menu.

In addition, library files from Versions 10 and prior can be imported by selecting Library> Convert Legacy (.alb) Library
Files from the program menu. Bear in mind, though, that older content may not be of the same quality as currently offered
catalogs and that legacy Manufacturer catalogs may be out of date.

CUSTOM GRAPHICS FILES

Chief Architect can use graphics files regardless of where they are stored on your system; however, it is a good idea to keep
your data organized in one location. If you have custom graphics files, including textures, images or backdrops that you
used in a previous program version, you can copy them manually using your operating system for use in Chief Architect
X15.

e Copy custom texture files to the Chief Architect X15 Textures folder located in the Chief Architect X15 Data folder.
e Copy custom image files to your Chief Architect X15 Images folder located in the Chief Architect X15 Data folder.

e Copy custom backdrop files to your Chief Architect X15 Backdrops folder located in the Chief Architect X15 Data
folder.

In Chief Architect X1 through X14, custom graphics were saved in the Chief Architect Data folder, as they are in version
X15. In version 10, they were located in the program’s installation directory, in folders that began with “My”. Custom
backdrops, for example, were saved in “My Backdrops”.

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image objects,
however, which are stored in the library so it is important to retain them. There are several tools available for adding
materials and images to the library.

Migrating Legacy Settings

The Migrate Settings dialog lets you migrate settings from the most recent legacy installation of your Chief Architect title
into Version X15. If you have extensively customized your Preferences, Toolbars, or Hotkeys, you may want to continue

using those settings. Before doing so, though, it is important to consider that you may make it harder to take advantage of
new tools and functionality in Version X15.
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PREFERENCES SETTINGS

Although you can migrate your Preferences settings from Versions X5 through X14 into Version X135, the settings that are
available in Version X15 may differ from previous program versions. You should review all the settings in the Preferences
dialog to make sure that they are set to suit your drawing needs.

CUSTOM TOOLBAR CONFIGURATIONS

It is possible to migrate toolbar configuration files from previous program versions into Version X15; however, it is also
possible that your migrated toolbars will be missing new tools available in Version X15.

Additionally, obsolete toolbar buttons are occasionally removed from the program and will also be removed from migrated
legacy toolbars. See New and Improved Features by Chapter on page 13 for information about new features as well as
removed or deprecated tools.

CuSTOM HOTKEYS

Like toolbar configurations, legacy hotkeys can be migrated into Chief Architect Premier X15. Bear in mind, though, that
occasionally the default hotkeys are modified to accommodate new features or changes in default system hotkeys.

Migrating Legacy Templates

Chief Architect X15 installs a selection of template plan and layout files that have been set up to take advantage of the
program’s updated tools and features. Although you can migrate your template files for use in Version X15, for best results
it is recommended that you either:

e Use the installed templates when creating new plans and layout files in Chief Architect X15

¢ Use the installed templates as the basis for creating new custom templates.

If you choose to continue using template files that you used in a previous program version, it is very important that you take
the time to review all the default settings in the file, making sure that they will continue to suit your needs in Version X15.
See New and Improved Features by Chapter on page 13.

Next, make sure that you are aware of changes in Version X15 that may affect legacy files: including templates. See
Considerations for Legacy Files on page 5.

When you are ready to proceed, make copies of your custom templates in the Chief Architect X15 Templates directory. The
Templates directory is located in the Chief Architect X15 Data folder. Next, open each template as you would a regular plan
or layout file, by selecting File> Open, and then save any changes you make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from the same
program version, as well. As with a template plan, take the time to go through the layout template’s defaults and make sure
they are suited for use in Version X15 and that their line weight scales do not conflict with those in your template plans.

Considerations for Legacy Files

As in all software, every new program version introduces changes to its functionality as well as to the user interface. If you
choose to bring a project forward, be sure to take a few moments to look it over in the new version and confirm that the new
functionality does not require you to make any modifications. Particularly if you have an approaching deadline, you may
find it best to finish the current project in the version of the software in which you began it.
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.2 Be sure to read this section before opening any plans created in
earlier versions of Chief Architect.

Chief Architect X15 can open the .plan and .layout files from prior versions. Files with the older .pl and .1a file extensions

are no longer supported, however, and cannot be opened by Chief Architect X15. Before opening any files created in earlier
versions of Chief Architect, it is important to be aware of changes made in the newest version and the effect they may have
on your legacy plan and layout files.

Please note that files saved in the latest program version cannot be read by older versions of the software. When a legacy
file is saved in the version X15, an unaltered copy of the original file is created in the Chief Architect X15 Data folder,
under Archives, which can still be opened in the original version.

FOR FILES CREATED IN VERSION X14 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X14 or prior, bear in
mind the following:

1. Window Casing Reveal
In Chief Architect X14 and prior, window casing had an Overlap Frame setting that controlled where casing was placed
relative to the window frame, and windows with different frame Width values for their top, bottom, and sides would also
have different reveals. In Version X135, this setting was replaced with a Reveal setting. When a legacy file is opened in
Version X15, any windows with different Width values will no longer have different reveals.

2. Text Indent and Margins
In Chief Architect X14 and prior, the indent and margins of text could vary depending on the font used. In Version X135,
indent and margins are not affected by settings in the font. When a legacy file is opened in Version X15, text with
varying indent and/or margins may be affected.

FOR FILES CREATED IN VERSION X13 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X13 or prior, bear in
mind the following:

1. Stair Walk Lines

In Chief Architect X13 and prior, Walk Lines were drawn on the "Dimensions" layer. In Version X14, they are drawn
on the same layer as the staircase. When a legacy file is opened in Version X15, any Walk Lines displaying in the file
may have different line color, weight, and style attributes.

2. Door Rough Openings

In Chief Architect X13 and prior, if a door's Floor to Bottom height was not sufficient to accommodate its Bottom
Rough Opening, the door's Top Rough Opening space would be increased in the model but not in the Door Specification
dialog. In Version X14, this no longer occurs: if the Floor to Bottom height is less than the Bottom Rough Opening, the
full Bottom Rough Opening is simply not modeled when framing is generated. When a legacy file is opened in Version
X15, its rough opening is modeled exactly as it was in the previous program version but its Top and Bottom Rough
Opening values now reflect how the rough opening is modeled.

3. NKBA Auto Dimensions

In Chief Architect X13 and prior, the NKBA Auto Dimension and NKBA Auto Elevation Dimension tools had restricted
default settings that met drawing standards set by the National Kitchen and Bath Association. In order to allow greater
flexibility in Version X15, these tools have been merged into the other Auto Dimension tools. In plan files created using
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a template installed with Version X15, NKBA compliant dimensions can be created using the "Kitchen and Bath
Dimension Defaults". In legacy plans opened in Version X15, use the "Legacy NKBA Dimension Defaults".

FOR FILES CREATED IN VERSION X12 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X12 or prior, bear in

mind the following:

1. Default 110V Ceiling Outlet
In Chief Architect X12 and prior, the 110V Outlet tool did not have the ability to place outlets in ceilings. In Version
X13, this ability was added, as was the new GFCI Outlet tool. When a legacy file is opened in Version X15, the new
Electrical Defaults settings for these items will automatically refer to objects in the Version X15 Core Catalogs. You
should confirm that these defaults meet your needs. If these default objects are not present in your library, a warning

message will inform you of the issue.

2. Sliding Door Hinge Side
In Chief Architect X12 and prior, the fixed or 'hinge' side of sliding doors was described as viewed from the exterior
side of the door. In Version X13, the hinge side is described using the more common method: as viewed from the
interior side. When a legacy file is opened in Version X15, all instances of the %hinge side% Name-Value Pair in
labels, schedules, and the Materials List will use the new method. You should confirm that the Hinge Side information
in labels, schedules, and Materials Lists meets your needs.

3. Automatic and Manual Dimension Layers
In Chief Architect X12 and prior, the system default layer for automatically generated dimension lines was "Dimensions,
Automatic", and the system default for manually drawn dimensions was "Dimensions, Manual". In Version X15, the
system default layer for all dimensions is simply "Dimensions". When a legacy file is opened in Version X15, automatic
dimensions that were on the "Dimensions, Automatic" layer in the earlier version will be placed on the "Dimensions,
Legacy" layer while any dimensions that were on the "Dimensions, Manual" layer in the previous version will be placed

on the "Dimensions" layer.

4. Gable Lines
In Chief Architect X12 and prior, Gable Lines with a Pitch value of 90° were allowed but did not affect automatic roof
generation. In Version X135, they are not supported. When a legacy file is opened in Version X15, any Gable Lines with
a Pitch of 90° will be removed automatically. This will not affect the current roof or automatic roof generation.

FOR FILES CREATED IN VERSION X11 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X11 or prior, bear in

mind the following:

1. Perspective Crop Mode
In Chief Architect X8 through X11, Perspective Crop Mode allowed older functionality governing zooming in cameras
from Version X7 and prior to be preserved in saved cameras in legacy plans migrated forward. This deprecated tool has
been removed from the program’s menu and toolbars in Version X12, although it can be migrated with legacy toolbars
and hotkeys. Saved cameras in legacy plans with this behavior enabled may become distorted if you pan or zoom in the
view. To permanently disable this behavior in a camera view and resolve the resulting distortion, select Window> Fill

Window or press the F6 key.
2. Layout Layer Sets

In Chief Architect X11 and prior, the Send to Layout dialog had a sticky Make Copy of Active Layer Set option that
created a new layer set for the layout view to help preserve layer settings in that view. This option was removed in
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Version X12 to encourage use of the multiple saved plan views. Saved plan views did not exist in Version X9 and prior,
however, so if you open a plan originally created in Version X9 or prior, extra care must be taken to make sure layout
views do not use the same layer set.

3. Materials List Formulas and Ruby Macros

Name-Value Pairs returned length, area, and volume measurements as Floats. In Version X12, these values are reported
using the Measurement class that includes both a numeric value and a unit. Older Ruby code may change behavior when
migrated into Version X12. When a legacy Ruby macro or materials list formula is evaluated, the program will
automatically check its version and prompt you to migrate it to the newest version.

4. Units of Measurement

In Chief Architect X11 and prior, units of measurement used by the program, including user-defined units, were stored
in a file called Units.dat located in the Chief Architect Data folder. Beginning in version X12, this information is saved

with other Preferences settings.

FOR FILES CREATED IN VERSION X10 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X10 or prior, bear in

mind the following:

1. Marker and Elevation Point Heights

In Chief Architect X10 and prior, the # sign could be added to the label of a Marker or Elevation Point and the label
would report the height of the Marker or the Elevation Point’s elevation. In Version X15, text macros are used to report
this information instead. In legacy plans, any # signs in Marker or Elevation Point labels will be replaced by the
%heightf% or %elevationf% macro.

2. Glass Shower Walls

In Chief Architect X10 and prior, the “Glass Shower” wall type was included in installed template files and like other
wall types, built to the structural layer of floors and ceilings and to the Main Layer of adjacent walls. In Version X15,
this wall type has the new Partition Wall attribute and instead builds to floor, ceiling, and wall surfaces. When a legacy
file is opened in Version X135, this wall type will be modified to have Partition Wall checked automatically and existing
walls will be affected by this change.

3. Fixture Schedules

In Chief Architect X10 and prior, 3D Elevations and Perspectives in Fixture Schedules showed cabinet fixtures inserted
into a cabinet. In Version X15, fixtures are shown on their own, even when they are inserted into an object in the plan.
When a legacy file is opened in Version X15, any fixture schedules showing 3D views of objects may be affected by
this change.

FOR FILES CREATED IN VERSION X9 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X9 or prior, bear in
mind the following:

1. Parallel Lights

In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light fixtures and Added Lights.
In Version X15, Parallel Lights are no longer supported. In legacy plans opened in Version X15, any Parallel Light
sources will be converted to Spot Lights.

2. Brick Ledges
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In Chief Architect X9 and prior, brick ledges were not represented in plan view. In Version X15, brick ledges are drawn
in plan view on the “Slabs” layer in stem wall and grade beam foundations, and on the “Walls, Foundation” layer in
monolithic slab foundations. When a legacy file is opened in Version X15, brick ledges, if present, will be drawn.

3. Window Types

In Chief Architect X9 and prior, the %type% text macro for windows reported some Window Types using abbreviations.
In Version X15, the abbreviations were replaced with full words. When a legacy file is opened in Version X135, the
width of Window Schedules may be affected, as may the width of columns in saved Materials Lists.

4. Joist Direction Lines

In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as “joists” and used nominal
lumber sizes in whole inches in US Unit plans. In Version X15, the platform’s framing Structure Type is reported and in
US Unit plans, the size is described in fractional inches. When a legacy file is opened in Version X15, Joist Direction
Lines will use the new, more accurate labeling.

5. Custom Schedule Columns

In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub Category to a type of object
on the Categories panel of the Preferences dialog. In Version X15, Sub Categories can no longer be created in this
manner. When a legacy file is opened in Version X15, any Sub Categories shown as custom schedule columns will be
converted to Custom Fields.

6. Registered User Text Macros

In Chief Architect X9 and prior, a selection of Registered User Text Macros could be inserted into Texts, Callouts, and
Markers. These macros no longer displayed any data and in Version X15, they are no longer recognized. When a legacy
file is opened in Version X15, any Registered User macros inserted into text objects are treated as regular text.

FOR FILES CREATED IN VERSION X8 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X8 or prior, bear in
mind the following:

1. Layer Names

In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it possible to assign different
names to the same layer in different layer sets. In Version X9, this option was no longer supported. When a legacy file is
opened in X15, the layer names used in the currently active layer set will be retained and any other layer names in other
layer sets will be discarded.

FOR FILES CREATED IN VERSION X7 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X7 or prior, bear in
mind the following:

1. Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend into exterior rooms with
“Use Soffit Surface for Ceiling” specified when located between the roof baseline and an interior room. In some legacy
plans opened in Version X15, the Length value for Boxed Eaves may need to be modified in the Roof Plane
Specification dialog.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and prior, it was an option for
Room Labels and Schedules only. In legacy plans opened in Version X8, any Schedules present in the drawing will be
assigned a Custom Text Style, as will their associated Schedule Defaults. If any Schedule Default is set to Use Layer for
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Text Style and no objects are present on that layer, a new Schedule Text Style will be created and assigned to that layer.
Room Labels are treated similarly: if any are present, they and their defaults will use a Custom Text Style. If a given
Room Label or Schedule has been sent to layout more than once and was set to use different Text Styles in each layout
view, it is possible that its appearance may be affected in some views.

FOR FILES CREATED IN VERSION X6 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6 or prior, bear in
mind the following:

1. Built-in Appliances
In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets had incorrect sizing
data. In legacy plans opened in Version X15, these appliances will not fit into the cabinet correctly and will need to be
replaced. Built-in dishwashers are particularly affected.

2. Formatting of Bulleted and Numbered Lists
In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy plans opened in
Version X7, Rich Text objects with bulleted and numbered lists may require adjustments.

3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The change in spacing
may increase the overall height of text objects using this font in X6 files opened in Version X15. X5 and prior legacy
files will not be affected by this change.

FOR FILES CREATED IN VERSION X5 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5 or prior, bear in
mind the following:

1. Name-Value Pairs for Doors and Windows

In Version X6, the NVPs door_style name, door type name, and window_type name were shortened to style name and
type name. Any object labels or text macros using these NVPs in legacy plans opened in Version X15 will need to be
replaced.

FOR FILES CREATED IN VERSION X4 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or prior, bear in
mind the following:

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in Version X5
and later, they are measured to the outside of the fascia or shadow boards, if present. In legacy plans opened in Version
X135, this will not affect the appearance of roof planes in floor plan view because in X4 and prior, roof plane polylines
represented the projected framing area whereas in Version X15 they represent the total projected area. But, the position
of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward displayed the interior material on the exterior side of
the door. This was corrected in Version X15. Doors modified to work around the old behavior could be affected in
legacy plans opened in Version X15.

3. Door Swing Direction and Louvers

10
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Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills
In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not wrapped. In
legacy plans opened in Version X15, the extents of wrapped lintels and sills will be adjusted so that they equal their
Extend setting.

5. Cabinet Feet
The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert into
cabinets effectively. In Version X15, the offset is set in the Cabinet Specification dialogs. When legacy plans are opened
in Version X135, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if one exists. Any customized
or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, then
those objects’ labels will display in that view when the plan is opened in Version X15.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in rendered
views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version X15, Transparent
materials with an Index of Refraction of 1.0 are transferred to the General Material class and assigned a Transparency
value of 100%. This will not affect these materials’ appearance in ray trace views, but will make them completely
invisible in rendered views.

8. Registered User Text Macros

In Chief Architect X4 and prior, a selection of Registered User Text Macros could be inserted into Texts, Callouts, and
Markers. These macros reported information that was provided when the program was installed and registered on the
computer. In Version X5 and later, the program no longer collects registered user information. When a legacy file is
opened in Version X15, any Registered User macros inserted into text objects are treated as regular text.

9. Invisible Beams

The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy plans are opened
in Version X15, any Invisible Beam walls will be converted to Invisible Walls.

FOR FILES CREATED IN VERSION X3 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or prior, bear in
mind the following:

1. Text Styles

The appearance of a number of objects that include text - including object labels, the North Pointer, Sun Angles, Joist
Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text Style. Their appearance
may be altered somewhat in legacy plans opened in Chief Architect X15.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X15. Lighting in legacy
plans may appear noticeably brighter when viewed in version X15.

FOR FILES CREATED IN VERSION X2 AND PRIOR

If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file management
changes and structural enhancements:

11
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1. Legacy file formats

Chief Architect9.5 and prior files were saved in .pl and .1a the file formats. These file formats files are no longer
supported and cannot be opened in version X15.

2. Material textures, images, and backdrops

Chief ArchitectX2 and prior installed with a catalog of library content, including a selection of material textures, images,
and backdrops. This library catalog is no longer installed with the program because it is now available for download on-
demand, so it will be possible to open a legacy plan in version X15 and encounter numerous missing file warnings. To
avoid this, we recommend using the Export Entire Plan feature in the original program version to create a folder that
includes the plan and all associated textures, images, and backdrops before opening this file in X15. This tool is renamed
Backup Entire Plan in version X15.

3. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as railings,
stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the subfloor. These
objects now measure their Floor to Bottom height from the floor finish surface by default, so it is possible that you may
notice height changes for these objects - particularly in saved, annotated cross section/elevation views.

4. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) in
version X2 and prior to 6 3/4” (169 mm) in Chief Architect X15. This may affect the riser heights of stairs, as well as
the thicknesses of landings attached to those stairs.

5. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height check box. If a cabinet,
fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or prior and was
located in a room with a floor height other than the default for the current floor, then the object’s Floor to Bottom
Height will change to equal that room’s floor height. The object’s position in the model will not change, however.

6. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file is
opened in version X15 and these wall types are detected, they are replaced by an updated, non-generic wall type.
Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side. Railings that define a
Deck room with Advanced Deck Framing Built will not acquire sheetrock layers.

7. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers of
sheetrock when the plan is opened in version X15. This can affect the appearance of staircases where they join to a floor
platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top edge of the staircase.

8. Deck rooms

In legacy plans opened in Chief Architect X15, Deck rooms with Advanced Deck Framing built retain the framing but
have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built are converted to
Balcony rooms.

9. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The Ambient
setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when opened in version
X15.

12
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The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans is
capped at 4” (100 mm).

10. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X15, Materials Lists are set to calculate
Total Linear Length. For a combination of linear length and piece count, select Mixed Reporting in the Structural
Member Reporting dialog.

11. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X15 it applies to the
entire plan. As a result, it is turned off by default in legacy plans opened in version X15.

New and Improved Features by Chapter

The following is a list of new and improved features in Premier Version X15. Where possible, cross-references to additional
information has been provided.

PROJECT PLANNING

e The Reference Plan can be offset along the X, Y, and Z axes as well as rotated in plan and camera views.
¢ Entries in the Time Log dialog can now be group-selected.

e The entries in the Time Log dialog can no longer be sorted by column.

PREFERENCES AND DEFAULT SETTINGS

¢ Save Dialog Size and Save Dialog Position are now separate settings in the Preferences dialog.

* New Double-Click Closes Browser option can be unchecked to prevent the Library Browser and any side windows it
is docked with from closing when a library item is double-clicked in the Filter Results panel.

* New Reset button for View Colors in the Preferences dialog.

e When a non-default User Catalog location is specified, you can now choose whether to copy the old folder's contents
to the new location.

e Access to the Default Designer Information was moved to the NEW PLANS panel of the Preferences dialog.
* New options in the Preferences dialog for copying Designer/Client Information from Templates into new files.

¢ The obsolete Turn on Connect Island Rooms When Opening Legacy Plans setting was removed from the Preferences
dialog.

TOOLBARS AND HOTKEYS

* New 2D and 3D Smooth Acceleration settings in the Gamepad Setup dialog control the speed at which acceleration
and deceleration occur.

e Toolbars can now be added to the Dashboard.

WINDOW AND VIEW TOOLS

¢ Three new Coordinate System Indicators can be set to display in various view types.

¢ The Saved Plan View Control is now available in the Chief Architect desktop Viewer software.
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CREATING OBJECTS

e Improved Object Snaps in cross section/elevation views.

DISPLAYING OBJECTS

« New tools for creating and editing custom Patterns 5.

EDITING OBJECTS
« New Select Next Side 53| edit button for architectural objects in 3D views.

e The Point to Point Move edit tool can now use Allowed Angles.
e The Trim Object(s) and Extend Object(s) edit tools are now available for trusses.

e Closed Polylines can now be converted to Terrain Modifiers.

CAD OBIJECTS
¢ The Sun Angle and North Pointer tools are no longer child tools of the CAD Line Tools parent and are now found in
the main CAD menu.
e CAD Insulation Boxes can now be assigned fill.
e Custom arrowhead styles can now be created using CAD blocks.
e CAD blocks can now be assigned labels.
e Editing the name of a CAD block as displayed in the Library Browser will now update the name of the block itself.
« New Add Insertion Point X option available in CAD Block windows.

e CAD Details in layout files have been deprecated: they can still be present in legacy layout files but cannot be created
in new ones.

WALLS, RAILINGS, AND FENCING

* New Extension setting for the bottom edge of exterior wall layers.

¢ Obsolete Connect Island Rooms check box has been removed from the General Wall Defaults dialog.

* Newel posts now have a Bottom Offset setting.

¢ New Horizontal Offset setting allows you to offset a railing relative to the floor platform edge it defines.
* Railings now have Horizontal and Vertical Offset options for rails. See Rails Panels.

e The Wall Type Definitions now features a tabbed interface along with its wall layer table.

¢ New Insert Floor Framing Below setting in the Wall Specification dialog controls whether extra support trusses are
generated under a selected wall.

e New Include Automatic End Truss Above setting in the Wall Specification dialog supplies the Attic wall above with
an end truss instead of framing.

RooMmS

¢ Island rooms no longer require an invisible Room Divider to connect them to other walls in a structure.
¢ Size information about the selected room or rooms is now reported in the Room Specification dialog.
« New Turn Off Ceiling B and Turn On Ceiling [Bg edit buttons.
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DIMENSIONS

Dimension lines can now locate closed cabinet doors, drawers, and panels in plan view.

Dimension lines can now locate molding edge profiles on countertops.

TEXT, CALLOUTS, AND MARKERS

Callout arrows now have a Transparency setting.

New Replace Fonts Font| tool.
Hyperlinks ‘® can now be inserted into Rich Text.

The Diameter, CenterLine and Square Foot symbols can now be inserted into text as Special Characters.

Indent and Margin values will now be an exact distance that will no longer vary between fonts.

DOORS AND WINDOWS

The Overlap Framing setting for window casing has been replaced with the Reveal setting like doors have.
New Panel Size settings let you set the height of a door panel independent of its jamb.

Door handles can now be resized and rotated in the Door Specification dialog.

New Door Size Includes Jamb and Door Size Excludes Jamb options in the Door Specification dialog.
New Window Size Includes Frame and Window Size Excludes Frame options in the Window Specification dialog.
Corner windows on both sides of a wall are now fully supported.

Interior window treatments are now drawn on the "Windows, Blinds & Curtains" layer.

Lintels can now be assigned to arched windows with Reflect Vertically specified.

Arches can now be assigned to all door and window types with the exception of symbol windows.

Door and window rough openings can now be defined in terms of Additional Space or Clearance Gap.
Improved how door frames are modeled for doors in curved walls.

Include Top Sill can now be unchecked when Vertical Placement is set to Top of Wall.

CABINETS

New Make Cabinet Molding Polyline #= edit tool.

Automatic cabinet end panels can now display in plan views.
Cabinet hardware can now be Centered both horizontally and vertically on doors and drawers.

New Display Molding Edges in Plan Views setting in the Base Cabinet Specification dialog allows countertop edge
profiles to be represented in plan view.

Pilasters can now be set to display in plan view.

New Placement options for Cabinet Corner Treatments.

Corner pilasters are now specified on the Box CONSTRUCTION panel of the Cabinet Specification dialog.
New Left and Right placement options for Front Pilasters.

Partitions now have Toe Kick settings.

Shelves and Partitions now have the Suppress Adjacent Room Moldings option.
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ELECTRICAL

The light sources assigned to Light symbols are now listed in a table rather than a drop-down list in the Electrical
Service Specification dialog.

Switches, Outlets, and Lights have a new Connect Electrical edit handle that allows you to draw a Connect Electrical
spline.

The Position Indicator of the selected light source now displays in the preview pane in the Electrical Service
Specification dialog.

Rope Lights now Center Lights along the length of each rope light by default.

SCHEDULES AND OBJECT LABELS

The Schedule Specification dialog now has a NUMBER FORMATTING panel that lets you set how numbers in each
column are formatted.

New Callout Symbol column displays each line item's schedule callout label, including the shape.
Schedule rows can now be sorted by column in either ascending or descending order in the Schedule Specification
dialog.

The colors of Callout Symbols, 2D Symbols, 3D Elevations, and 3D Perspectives can now be drawn From Plan or
From Schedule.

A minimum number of schedule rows can now be specified.
New schedule columns:
* Header Height for windows and doors
e Percent Openings (Energy) for walls
* Volume for rooms
e Requirements for fixtures
e Type for fixtures, furniture, and millwork
e Door Style and Drawer Style for cabinets
3D preview columns are now available for framing and trusses in schedules.

Multiple Schedule Defaults can now be selected in the Default Settings dialog.

STAIRS, RAMPS, AND LANDINGS

The radius of curved stairs can now be specified.
Stairs, Ramps, and Landings now have a railing Horizontal Offset option in their specification dialogs.

Stair, Ramp, and Landing newels now have a Bottom Offset setting and an option for newel bottoms to be Clipped at
the floor surface.

ROOFS

Individual roof planes as well as automatic Dormers now have a Framing Method option in their specification dialog
that lets you select either Trusses or Rafters.

The Skylight check box has been removed from the Skylight Specification dialog.
New Roof Hole | tool.

Skylight frames can now display in plan view.
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New Skylight Shape options: Rectangle, Circle, Ellipse, and Oval, as well as an object preview, in the Skylight
Specification dialog.

Skylight shape can no longer be modified using edit handles.
New Edit Skylight Shape @ edit tool.

The Set as Default edit button is now available for automatic dormers.

The Automatically Place Roof Intersection Points option in the Preferences dialog has been removed in favor of the
new Place Roof Plane Intersection Point [X| edit tool for a selected roof plane.

New Heel Height setting and improved interface for Roof Height settings in the Build Roof dialog.

New Auto Resize Window option in the Dormer Specification dialog can be unchecked to prevent dormer windows
from resizing.

New Create Shaft to Room Below option in the Dormer Specification dialog creates an opening in the floor platform
below a dormer to the floor below, and encloses the inside of the dormer with walls.

FRAMING AND TRUSSES

Roof and Floor/Ceiling Trusses can now be generated automatically.

Ceiling framing no longer generates automatically where roof trusses are present.
New "U Shaped" framing configuration for Wall Corners.

New check box for Ridge beams allows you to generate them or not.

New Include Ridges check box lets you controll whether sloped ceiling planes receive ridge boards when roof
framing is generated.

Trusses can now be deleted from a plan in the Truss Detail.

TRIM AND MOLDINGS

Railings now have Horizontal and Vertical Offset options for rails.

THE LIBRARY

Redesigned Library Browser side window.

Custom Tags let you organize items into categories for efficient searching and filtering.

Chief Architect now checks for catalog updates automatically and identifies catalogs with new content.
The Library Browser's Search function now includes online content.

New Go Back and Go Forward in History buttons let you navigate your library search history.

New Restore option lets you retrieve items in the Trash and place them back in the User Catalog.
New Vacuum option lets you remove data associated with deleted content from the library database.
Up to 398 instances of the Place Library Object button can now be used at a time.

Duplicate items are now identified when content is imported into the User Catalog.

The Search Attributes for items in the Core, Bonus, and Manufacturer Catalogs are no longer editable.

SYMBOL OBJECTS

The Symbol Specification dialog's panels are now found in the Symbol Object Specification dialogs.

New Dedicated Circuit requirement attribute in the Symbol Object Specification dialog for fixtures. See Options
Panel.
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The Suppress Adjacent Room Moldings option is now available for fixture and furniture objects in their
specification dialog.

Fixture and furniture symbols set to be placed on base cabinets or tables will now also place on Custom Countertops.

OTHER OBJECTS

3D Solid objects can now be added to the library.

MATERIALS

The Transparency setting is now available for materials assigned the Transparent class for use in non-ray traced
views.

3D VIEWS

New Below Grade Override options for line color, style, and weight in the Cross Section/Elevation Specification
dialog.

Virtual Reality =¢)is now an option in the desktop Chief Architect Viewer.

New Depth of Field options allows you to add blur to out-of-focus objects in Standard, Vector View, Physically
Based, Glass House, and Technical Illustration renderings.

Position and Navigation settings were moved from the General panel to the new POSITIONING panel in the Camera
Specification dialog.

New Depth Cue i) tool applies a partially transparent mask over surfaces located past a set distance from a cross

section/elevation camera.
New Extend Terrain to Horizon option for camera views.

When Camera Bumps of Walls is enabled, new Turn Automatically option controls whether cameras also change
direction when they approach walls, doors, and staircases.

The Framing Back Clip distance can now be set for individual cross section/elevation views rather than plan-wide.

3D RENDERING AND RAY TRACING

New Denoise View & tool removes light artifacts and the appearance of graininess from active GPU Ray Trace

views.
Improved Generated Sky simulates the sky at different times of day based on the position of the Generic Sun.

New Move Sun 3, tool lets you adjust the Generic Sun's position in camera views using the mouse.

The moon and stars are now represented in nighttime camera views when the Generated Sky is in use. The new Move
Moon |-€ | tool lets you adjust the moon's position.

The color of Opaque Window Glass can now be specified.

New Automatic and Manual Exposure settings for Physically Based and Clay renderings.

Light sources' Show Position in Camera View status can now be set in the Adjust Lights dialog.
Totals for Light Objects, Light Sources, and In Use lights are now reported in the Adjust Lights dialog.
The Line Drawing Rendering Technique has been renamed Hand Drawn Lines.

The minimum Hand Drawn Lines Thickness has been lowered to 0.25.

Soft Sun Shadows can now be specified in GPU Ray Trace Views.
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PICTURES, IMAGES, AND WALKTHROUGHS

Plants and other image objects can now be assigned 2D CAD blocks from the Library.

Imported PDF boxes now have labels and an object preview in their specification dialog.

Picture objects now have labels and an object preview in their specification dialog.

Imported Picture and PDF Boxes are now placed on the "Picture/PDF Boxes" layer by default.

The obsolete Black and White Dither option has been removed from the Picture File Box Specification dialog.

Spherical Panoramic Backdrops can no longer be used in Orthographic Overviews.

TERRAIN

New Grass Region [@)] tools create regions of realistic generated 3D grass.

MATERIALS LIST

New Live Materials List is dynamically linked to the model and updates as changes are made.

The Font, Colors, and Grid style for Materials Lists can now be specified for each list in its specification dialog
rather than globally.

LAyouT

Send to Layout is now an option in a selected view's contextual menu in the Project Browser.

New Send All Remaining Views to Layout With These Settings check box lets you send multiple views to layout
with one instance of the Send to Layout dialog.

The LAYER SET panel in the Layout Box Specification dialog is now available when multiple layout boxes are
selected.

RUBY IN CHIEF ARCHITECT

New NVPS for walls, doors, stairs, fixture objects, and callouts/notes/construction lines.
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